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#include <LiquidCrystal.h> 
#include <Wire.h> 
#include "RTClib.h"   
 

LiquidCrystal lcd (13, 12, 11, 10, 9, 8); 
RTC_DS1307 RTC; 
 
volatile float tiempo0 = 0; 
volatile float tiempo1 = 0; 
 
const int hallPin = 2; 
const int pin_mq = 3; 
const int pot = A2; 
const int LDR = A1; 
const int LEDL = 7; 
const int LEDA = 6; 
const int BOTON1 = 5; 
const int BOTON2 = 4; 
const int BOTON3 = A3; 
 
int val1;   //valor botón temperatura 
int val2;   //valor botón velocidad 
int val3;   //valor botón batería 
int valor;  //variable que almacena la lectura del potenciómetro 
int posicion;  //posición del potenciómetro en tanto por ciento 
int luminosidad; 
int umbral = 500; //valor entre 0 y 1023 
 

int cont = 0; 
int estadoActual1 = 0; 
int estadoActual2 = 0; 
int estadoUltimo = 0; 
float VEL = 0.00; 
float VELMAX = 0.00; 
float omega = 0; 
const float pi = 3.14159; 
const float dosPi = 6.28318; 
const float radioRueda = 0.33;   //rueda de 26’’, en m. Hace falta para calcular la velocidad lineal  
float perimetroRueda = dosPi*(radioRueda);  //calcula el perímetro en m. 
float distRecorrida = 0; 
float distKM = 0; 
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void setup () { 
  Wire.begin ();   //configura el bus I2C estableciendo Arduino como MASTER 
  RTC.begin (); 
  if (! RTC.isrunning()) // se verifica si el módulo rtc está en funcionamiento, de lo contrario, 

se imprime: RTC is NOT running! 
     { 
   lcd.println ("RTC is NOT running!"); 
   delay (10000); 
     } 
   RTC.adjust (DateTime (__DATE__, __TIME__));  

pinMode (pin_mq, INPUT); 
   pinMode (pot, INPUT); 
   pinMode (BOTON1, INPUT); 
  pinMode (BOTON2, INPUT); 
   pinMode (BOTON3, INPUT); 
   pinMode (LEDL, OUTPUT); 
   pinMode (LEDA, OUTPUT); 
   pinMode (hallPin, INPUT); 
   
   lcd.begin (16, 2); 
   lcd.clear (); 
   attachInterrupt (0, pulsoRueda, FALLING); 
} 
 
void loop () { 

  calidad (); 
  luz (); 
  val1 = digitalRead (BOTON1); 
  val2 = digitalRead (BOTON2); 
  val3 = digitalRead (BOTON3); 
  if (val1 == HIGH) { 

    lcd.print ("Temperatura"); 
    lcd.setCursor (0, 1); 
   lcd.print ("C="); 
    float centigrados = leerGradosC (); 
    lcd.setCursor (2, 1); 
    lcd.print (centigrados); 
    delay (1000); 
    lcd.clear (); 
       } 

 else if (val 2== HIGH) { 
   velocidad () 
  delay (1000); 
   lcd.clear (); 
      } 

 else if (val3 == HIGH) { 
   tension (); 
   delay (1000); 
   lcd.clear (); 
     } 
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 else {  
   mostrarRTCLCD (); 
   delay (1000); 
   lcd.clear (); 
     } 
} 
 
float leerGradosC() { 

float dato; 
float gradosC; 
dato = analogRead (A0); 
gradosC = ((500.0 * dato /1024)-50); 
return gradosC;   
 } 

 
void calidad () 
{ 

  boolean mq_estado = digitalRead(pin_mq);  //Leemos el sensor 
  if (mq_estado)    //si la salida del sensor es 1 
  { 

     digitalWrite (LEDA, LOW); //apaga led rojo 
    delay (10); 
        } 

  else     //si la salida del sensor es 0 
  { 

    digitalWrite (LEDA, HIGH);  //enciende led rojo 
     delay (10); 

  } 
} 
 
void luz () 
{ 

 luminosidad = analogRead (LDR); 
 if (luminosidad > umbral)   //valor experimental 
 { 

    digitalWrite (LEDL, LOW); 
       } 

  else 
  { 

    digitalWrite (LEDL, HIGH); 
    delay (500); 
    digitalWrite (LEDL, LOW); 
    delay (500); 

  } 
} 
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void tensión () 
{ 

 valor = analogRead (pot); 
 posicion = map (valor, 0, 1023, 0, 100); 
 lcd.print ("Nivel Bateria"); 
 lcd.setCursor (0,1); 
 lcd.print (posicion); 
 lcd.setCursor (2,1); 
 lcd.print ("%"); 
  

} 
 
void velocidad () 
{ 

 lcd.setCursor (0, 0); 
 lcd.print ("D = "); 
 lcd.setCursor (0, 1); 
 lcd.print ("V = "); 
 lcd.setCursor (9, 1); 
 lcd.prin t("km/h"); 
 lcd.setCursor (4, 0); 
  if (distRecorrida <= 999) {                                

        lcd.print (distRecorrida); 
         lcd.write ("m"); 
         delay (1000); 
              } 

else {                          
lcd.print (distKM); 
lcd.write ("Km"); 
delay (1000); 

              } 
  lcd.setCursor (4, 1); 
  lcd.print (VEL, 2); 
  if (VEL >= VELMAX) { 
   VELMAX = VEL; 
  } 
  else { 
  } 
  estadoActual1 = digitalRead (2); 
        delay (10); 
        estadoActual2 = digitalRead (2); 
        if (estadoActual1 == estadoActual2) { //Si los estados no son iguales, el sketch no          

hace gran cosa 
              if (estadoActual1 != estadoUltimo){ 
                    if (estadoActual1 == HIGH) { 
                        cont = cont + 1; 
                        distancia (); 
                 }         
              } 
        }         
   estadoUltimo= estadoActual1; 
} 
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void pulsoRueda () { 
tiempo1 = micros (); 
omega = (dosPi * 1000000 / (tiempo1 - tiempo0));  //Omega en radianes/segundo 
VEL = omega * radioRueda * 3.6;      //Velocidad en Km/hora 
tiempo0 = tiempo1; 
} 

 
void distancia () { 

distRecorrida = perimetroRueda*cont; 
distKM = distRecorrida/1000; 
 } 

 
void mostrarRTCLCD ()   //Función que lee los datos de modulo RTC y después los 

imprime en el display 
{ 

DateTime now = RTC.now ();   // obtiene datos del módulo RTC 
lcd.clear (); 
lcd.setCursor (0, 0); 
if (now.day () < 10) 
{ 

lcd.print ("0"); 
     } 

lcd.print (now.day (), DEC);   // imprime el día 
lcd.print ('/'); 
if (now.month () < 10) 
 { 

 lcd.print ("0"); 
 } 
lcd.print (now.month (), DEC);  // imprime el mes 
lcd.print ('/'); 
lcd.print (now.year (), DEC);   //imprime el año 
lcd.setCursor (0,1); 
if (now.hour () < 10) 
 { 

 lcd.print ("0"); 
 } 
lcd.print (now.hour(), DEC);   // imprime la hora 
lcd.print (':'); 
if(now.minute()  <  10) 
{ 

lcd.print ("0"); 
      } 

lcd.print (now.minute(), DEC);  // imprime los minutos 
lcd.print (':'); 
if (now.second() < 10) 
 { 

  lcd.print ("0"); 
       } 

lcd.print (now.second(), DEC);  // imprime los segundos 
} 
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The  Arduino  Uno  is  a  microcontroller  board  based  on  the  ATmega328  (datasheet).  It  has  14  digital 
input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, a 16 MHz crystal oscillator, a 
USB connection,  a power jack,  an ICSP header,  and a reset  button.  It  contains everything needed to 
support the microcontroller; simply connect it to a computer with a USB cable or power it with a AC-to-DC 
adapter or battery to get started. The Uno differs from all preceding boards in that it does not use the FTDI 
USB-to-serial driver chip. Instead, it features the Atmega8U2 programmed as a USB-to-serial converter.

"Uno" means one in Italian and is named to mark the upcoming release of Arduino 1.0. The Uno and version 
1.0 will be the reference versions of Arduno, moving forward. The Uno is the latest in a series of USB 
Arduino boards, and the reference model for the Arduino platform; for a comparison with previous versions, 
see the index of Arduino boards.
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EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf

Microcontroller ATmega328
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 14 (of which 6 provide PWM output)
Analog Input Pins 6
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA

Flash Memory 32 KB of which 0.5 KB used by 
bootloader

SRAM 2 KB 
EEPROM 1 KB 
Clock Speed 16 MHz
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The Arduino Uno can be powered via the USB connection or with an external power supply. The power  
source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The adapter 
can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a 
battery can be inserted in the Gnd and Vin pin headers of the POWER connector.

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V 
pin may supply less than five volts and the board may be unstable. If using more than 12V, the voltage 
regulator may overheat and damage the board.  The recommended range is 7 to 12 volts.

The power pins are as follows: 

• VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 
5 volts from the USB connection or other regulated power source). You can supply voltage through 
this pin, or, if supplying voltage via the power jack, access it through this pin. 

• 5V. The regulated power supply used to power the microcontroller and other components on the 
board. This can come either from VIN via an on-board regulator, or be supplied by USB or another 
regulated 5V supply. 

• 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA. 
• GND. Ground pins. 

The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is used for the bootloader); It  
has also 2 KB of SRAM and 1 KB of EEPROM (which can be read and written with the EEPROM library).

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(), digitalWrite(), and 
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and 
has an internal  pull-up resistor  (disconnected by default)  of  20-50 kOhms.  In  addition,  some pins have 
specialized functions: 

• Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. TThese pins are 
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip . 

• External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value, a 
rising or falling edge, or a change in value. See the attachInterrupt() function for details. 

• PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function. 
• SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication, which, 

although provided by the underlying hardware, is not currently included in the Arduino language. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is  
on, when the pin is LOW, it's off. 
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The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By  
default they measure from ground to 5 volts, though is it possible to change the upper end of their range 
using  the  AREF  pin  and  the  analogReference()  function.  Additionally,  some  pins  have  specialized 
functionality: 

• I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire library. 

There are a couple of other pins on the board: 

• AREF. Reference voltage for the analog inputs. Used with analogReference(). 
• Reset. Bring this line LOW to reset  the microcontroller.  Typically  used to add a reset  button to 

shields which block the one on the board. 

See also the mapping between Arduino pins and Atmega328 ports. 

The Arduino Uno has a number of facilities for communicating with a computer, another Arduino, or other 
microcontrollers. The ATmega328 provides UART TTL (5V) serial communication, which is available on 
digital pins 0 (RX) and 1 (TX). An ATmega8U2 on the board channels this serial communication over USB 
and appears as a virtual com port to software on the computer. The '8U2 firmware uses the standard USB 
COM drivers, and no external driver is needed. However, on Windows, an *.inf file is required..

The Arduino software includes a serial monitor which allows simple textual data to be sent to and from the 
Arduino board. The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-
serial chip and USB connection to the computer (but not for serial communication on pins 0 and 1).

A SoftwareSerial library allows for serial communication on any of the Uno's digital pins. 

The  ATmega328 also support  I2C (TWI) and SPI communication. The Arduino software includes a Wire 
library to simplify use of the  I2C bus; see the  documentation for details. To use the SPI communication, 
please see the ATmega328 datasheet. 

The  Arduino  Uno  can  be  programmed  with  the  Arduino  software  (download).  Select  "Arduino  Uno  w/ 
ATmega328" from the  Tools > Board menu (according to the microcontroller on your board). For details,  
see the reference and tutorials. 

The ATmega328 on the Arduino Uno comes preburned with a bootloader that allows you to upload new code 
to  it  without  the use of  an external  hardware  programmer.  It  communicates  using the original  STK500 
protocol (reference, C header files). 

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 

The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded with a DFU bootloader,  
which can be activated by connecting the solder jumper on the back of the board (near the map of Italy) and  
then resetting the 8U2. You can then use Atmel's FLIP software (Windows) or the DFU programmer (Mac 
OS X and Linux) to load a new firmware. Or you can use the ISP header with an external programmer 
(overwriting the DFU bootloader). 
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Rather than requiring a physical press of the reset button before an upload, the Arduino Uno is designed in a  
way that allows it to be reset by software running on a connected computer. One of the hardware flow control  
lines (DTR)  of  the ATmega8U2 is  connected to  the reset  line of  the ATmega328 via  a  100 nanofarad 
capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the chip. The 
Arduino software uses this capability to allow you to upload code by simply pressing the upload button in the  
Arduino environment. This means that the bootloader can have a shorter timeout, as the lowering of DTR 
can be well-coordinated with the start of the upload. 

This setup has other implications. When the Uno is connected to either a computer running Mac OS X or 
Linux, it resets each time a connection is made to it from software (via USB). For the following half-second or 
so, the bootloader is running on the  Uno. While it is programmed to ignore malformed data (i.e. anything 
besides  an  upload  of  new code),  it  will  intercept  the  first  few bytes  of  data  sent  to  the board  after  a  
connection is opened. If a sketch running on the board receives one-time configuration or other data when it  
first  starts,  make sure  that  the  software  with  which  it  communicates  waits  a  second after  opening the  
connection and before sending this data. 

The Uno contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can  
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset 
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details. 

The  Arduino  Uno has  a  resettable  polyfuse  that  protects  your  computer's  USB ports  from shorts  and 
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer 
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection 
until the short or overload is removed. 

The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, with the USB connector 
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to 
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple 
of the 100 mil spacing of the other pins. 
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Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed  using  the  Arduino  programming  language (based  on  Wiring)  and  the  Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions.  http://arduino.cc/en/Guide/HomePage

Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your 
first  program on the arduino board. To 
select “blink led”, the physical translation 
of  the  well  known  programming  “hello 
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

In Tools>Board select

Now you have to go to
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to.
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1.      Warranties 

1.1     The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The 
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,  
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from 
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems 
necessary.

1.2     If any  products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability 
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the 
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3     EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4     Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the 
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other 
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5     The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause 
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapons systems. Arduino products are neither designed nor intended for use in military or aerospace applications or 
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino products which  is solely 
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its 
products and any use of Arduino products in Customer's applications, notwithstanding any applications-related information or support that may be 
provided by the producer.

2.       Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,  
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this 
terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3.        Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or  
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the 
possibility of such damages. This section will survive the termination of the warranty period.

4.      Changes to specifications

The producer  may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or 
characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is 
subject to change without notice. Do not finalize a design with this information.

The producer of Arduino  has joined the Impatto Zero® 
policy of LifeGate.it. For each Arduino board produced is 
created / looked after half  squared Km of Costa Rica’s 
forest’s.

13



TECHNICAL  DATA            MQ-135  GAS SENSOR

  FEATURES
    Wide detecting scope             Fast response and High sensitivity
    Stable and long life               Simple drive circuit

  APPLICATION
    They are used in air quality control equipments for buildings/offices, are suitable for detecting

  of NH3,NOx, alcohol, Benzene, smoke,CO2 ,etc.
  SPECIFICATIONS

    A. Standard work condition
Symbol Parameter name Technical  condition Remarks
  Vc Circuit voltage 5V±0.1 AC OR DC
  VH Heating voltage 5V±0.1 ACOR DC
  RL Load resistance can adjust
  RH Heater resistance 33Ω±5% Room Tem
  PH Heating consumption less than 800mw

         B. Environment  condition
Symbol Parameter name Technical condition Remarks
  Tao Using Tem -10�-45�
  Tas Storage Tem -20�-70�
  RH Related humidity less than 95%Rh
  O2 Oxygen concentration 21%(standard condition)Oxygen

concentration can affect sensitivity
minimum  value is
over 2%

        C. Sensitivity characteristic
Symbol Parameter name     Technical parameter Ramark 2
Rs Sensing

Resistance
        30KΩ-200KΩ
       (100ppm NH3 )

α
 (200/50)
  NH3

Concentration
 Slope  rate           ≤0.65

Standard
Detecting
Condition

        Temp: 20�±2�    Vc:5V±0.1
       Humidity: 65%±5%   Vh: 5V±0.1

Preheat time                    Over 24 hour

Detecting concentration
scope�
10ppm-300ppm NH3
10ppm-1000ppm
Benzene
10ppm-300ppm
Alcohol

        D. Structure and configuration, basic measuring circuit

    S
mic
cru

1

2
3
4
5
6

7
8
9

C

    Parts Materials
Gas sensing
   layer

SnO2

Electrode Au
Electrode line Pt
Heater coil Ni-Cr alloy
Tubular ceramic Al2O3
Anti-explosion
network

Stainless steel gauze
(SUS316 100-mesh)

Clamp  ring Copper  plating Ni
Resin  base Bakelite
Tube Pin Copper plating Ni
tructure and configuration of MQ-135 gas sensor is shown as Fig. 1 (Configuration A or B), sensor composed by
ro AL2O3 ceramic tube, Tin Dioxide (SnO2) sensitive layer, measuring electrode and heater are fixed into a
st   made by plastic and stainless steel net. The heater provides necessary work conditions for work of sensitive

AÏ ò AÏ ò

Fig. 1

onfiguration A Configuration B

Fig.2
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components. The enveloped MQ-135 have 6 pin ,4 of them are used to fetch signals, and other 2 are used for
providing heating current.
     Electric parameter measurement circuit is shown as  Fig.2
    E. Sensitivity characteristic curve

 
          Fig.2 sensitivity characteristics of the MQ-135
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Fig.3 is shows the typical
ENSITVITY ADJUSTMENT
 Resistance value of MQ-135 is difference to various kinds and various concentration gases. So,When using

is components, sensitivity adjustment is very necessary. we recommend that you calibrate the detector for
0ppm NH3 or 50ppm Alcohol concentration in air and use value of Load resistancethat( RL) about 20 KΩ(10KΩ
 47 KΩ).   When accurately measuring, the proper alarm point for the gas detector should be determined after
nsidering the temperature and humidity influence.
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sensitivity characteristics of
the MQ-135 for several gases.
   in their: Temp: 20� �
   Humidity: 65%�
   O2 concentration 21%
   RL=20kΩ
Ro: sensor resistance at 100ppm of
   NH3 in the clean air.
Rs:sensor resistance at various
   concentrations of gases.

Fig.4 is shows the typical dependence of
the MQ-135 on temperature and humidity.
Ro: sensor resistance at 100ppm of NH3 in air
    at 33%RH and 20 degree.
Rs: sensor resistance at 100ppm of NH3

       at different temperatures and humidities.
Fig.4
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